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Safety Guidelines 

This document contains notices which you should observe to ensure your own personal safety as well as to avoid property damage. The 
notices referring to your personal safety are highlighted in the manual by a safety alert symbol, notices referring to property damage only 
have no safety alert symbol 

 

Danger 

Indicates an imminently hazardous situation which, if not avoided, will result in death or serious injury. 

 

Warning 

Indicates a potentially hazardous situation which, if not avoided, could result in death or serious injury. 

 

Caution 

Used with the safety alert symbol indicates a potentially hazardous situation which, if not avoided, may result in minor or 
moderate injury. 

 Notice 

Used without the safety alert symbol indicates a potential situation which, if not avoided, may result in an undesirable result or 
state. 

When several danger levels apply, the notices of the highest level (lower number) are always displayed. If a notice refers to personal 
damages with the safety alert symbol, then another notice may be added warning of property damage. 

Qualified Personnel 

The device/system may only be set up and operated in conjunction with this documentation. Only qualified personnel should be allowed to 
install and work on the equipment. Qualified persons are defined as persons who are authorized to commission, to earth, and to tag cir-
cuits, equipment and systems in accordance with established safety practices and standards. 

Intended Use 

Please note the following: 

 

Warning 

This device and its components may only be used for the applications described in the catalog or technical description, and 
only in connection with devices or components from other manufacturers approved or recommended by Siemens. This prod-
uct can only function correctly and safely if it is transported, stored, set up and installed correctly, and operated and main-
tained as recommended. 
 

Trademarks 

All designations marked with ® are registered trademarks of Siemens AG. Other designations in this documentation might be trademarks 
which, if used by third parties for their purposes, might infringe upon the rights of the proprietors. 

Copyright Siemens AG 2016. All rights reserved. 

Reproduction, transmission or use of this document or its contents is not permitted without express written authority. Offenders will be 
liable for damages. All rights, including rights created by patent grant or registration of a utility model or design, are reserved. 

Disclaimer of Liability 

We have checked the contents of this document for agreement with the hardware and software described. Since deviations cannot be 
precluded entirely, we cannot guarantee full agreement. However, the data in the manual are reviewed regularly, and any necessary cor-
rections will be included in subsequent editions. Suggestions for improvement are welcomed. 

 
Siemens AG 
Industry Sector 
P.O. Box 4848 
90327 Nuremberg 
Germany 

Siemens AG 2016 
Technical data subject to change 
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1 Preface 

 

1.1 Purpose of this Document 

This document provides detailed information about the functionalities and usage of the software 

 CMS X-Tools 

of the CMS product line. 

In addition to the detailed information about each dialog and functionality of the X-Tools Client which is found 
within this document, also the following documentation is available: 

 CMS X-Tools - User Manual - 01 - Introduction 

o provides an introduction into the basic functionalities of CMS X-Tools 

 CMS X-Tools  - User Manual - 03 - Main Management System 

o provides detailed information about the functionality which is provided by the Main Management Sys-
tem 

 CMS X-Tools  - User Manual - 04 - Device Management System 

o provides detailed information about the functionality which is provided by the Device Management 
System 

 CMS X-Tools  - User Manual - 05 - Monitoring System 

o provides detailed information about the functionality which is provided by the Monitoring System 

 CMS X-Tools  - User Manual - 06 - Analyzing System 

o provides detailed information about the functionality which is provided by the Analyzing System 

 CMS X-Tools  - User Manual - 07 - Storage System 

o provides detailed information about the functionality which is provided by the Storage System 

 CMS X-Tools  - Release Notes 

o provides additional information about the released version of CMS X-Tools 

 CMS X-Tools  - Change Log 

o provides an overview about the changes which have been introduced with the current version of CMS 
X-Tools 

1.2 Validity of this Document 

This document is valid for the following software: 

 CMS X-Tools V 04.04 

During the following pages, these software packages will be referred to by the term X-Tools. Not all editions of 
X-Tools provide all functionality, thus it may be that some of the descriptions within the user manual do not 
apply to all editions. 

1.3 Audience 

This document is intended for personnel involved in the commissioning and using of the software: 

 X-Tools 
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1.4 Notations 

The following notations are used within this document: 

 bold, italic text is being used for the main executables of X-Tools 

o examples: X-Tools Client, X-Tools Server 

 bold text is being used for the software modules of X-Tools 

o examples: Main Management System, Device Profile Editor, IPE Socket T001 

 green text is being used for controls like tables and trees 

o examples: Main Profile Settings table, Device Profile Data table 

 orange text is being used for simple controls like a menu button, a single row/column/cell of a table or a 
branch of a tree 

o examples: Open… menu button, IP Address column, Target Device Name cell, Interfaces Branch 

 dark yellow text is being used for the entries of menus and context menus 

o examples: Advanced Append…, Edit 

 Camel Notation is being used for major terms of X-Tools 

o examples: Main Profile, Interface Profile, User Accounts File, Analyzing Function 

 < and > brackets are being used for keyboard keys 

o examples: <Ctrl>, <Alt>, <Shift>, <Del> 

 [ and ] brackets are being used for mouse operations 

o examples: [left mouse button down], [mouse move] 
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2 X-Tools Client 

 

2.1 X-Tools Client 

2.1.1 Overview 

The X-Tools Client provides the user interface for the configuration and maintenance of one or multiple X-
Tools Servers. It is the starting point for and hosts all of the available functionality. 

The following screenshot shows an example of an X-Tools Client: 

 

Figure 1: Example of an X-Tools Client 

2.1.2 Title Bar 

The Title Bar of the X-Tools Client displays detailed information about its edition and version. In addition, the 
full path to the currently opened file can be displayed directly within the title bar. 

2.1.3 Menu Bar 

The Menu Bar provides direct access to the functionality of the X-Tools Client. 

The following functionality is available via the File menu: 

Menu Item Description 

Exit closes the X-Tools Client 

The following functionality is available via the View menu: 

Menu Item Description 

Title Bar toggles whether the Title Bar shall be shown or hidden 

Menu Bar toggles whether the Menu Bar shall be shown or hidden 

MDS Explorer toggles whether the MDS Explorer shall be shown or hidden 

Main Management System toggles whether the Main Management System shall be shown or hidden 

Device Management System toggles whether the Device Management System shall be shown or hidden 

Monitoring System toggles whether the Monitoring System shall be shown or hidden 

Analyzing System toggles whether the Analyzing System shall be shown or hidden 

Storage System toggles whether the Storage System shall be shown or hidden 
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The following functionality is available via the Window menu: 

Menu Item Description 

Size > … changes the size of the X-Tools Client 

Mode > … changes the window mode of the X-Tools Client 

Arrange > … allows to arrange the child dialogs which are opened within X-Tools Client automatically 

Background Grid > … changes the resolution of the background grid of the X-Tools Client, which is used for the moving 
of child dialogs in case the manual window mode is active 

The following functionality is available via the Sub-Windows menu: 

Menu Item Description 

Title Bar > … allows to show/hide the Title Bar of all child dialogs of the X-Tools Client 

Menu Bar > … allows to show/hide the Menu Bar of all child dialogs of the X-Tools Client 

Configuration Area > … allows to show/hide the Configuration Area of all child dialogs of the X-Tools Client 

Mode > … changes the window mode of all child dialogs of the X-Tools Client 

Arrange > … allows to arrange the child dialogs which are opened within the child dialogs of the X-Tools Client 
automatically 

Background Grid > … changes the resolution of the background grid of all child dialogs of the X-Tools Client, which is 
used for the moving of their child dialogs in case the manual window mode is active 

2.1.4 Workspace 

In case the window mode is “Tabbed”, the order of the present tabs is always the same and can not be 
changed. In this case, the systems of the X-Tools Client are arranged in the following order (left to right): 

 Main Management System 

 Device Management System 

 Monitoring System 

 Analyzing System 

 Storage System 
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2.2 Master Data System Explorer 

2.2.1 Overview 

The Master Data System Explorer (in the following, the MDS Explorer) is used in order to visualize and main-
tain all of the currently available data from all of the currently connected X-Tools Servers. It is displayed as a 
tree which contains all of the relevant and available MDS Explorer items. Via Drag&Drop it is possible to move 
items within the MDS Explorer and from the MDS Explorer to other parts of the X-Tools Client. The following 
lines provide a short overview about the information that is available from the MDS Explorer. 

The following screenshot shows an example of a MDS Explorer: 

 

Figure 2: Example of a MDS Explorer 
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2.2.2 Menu Bar 

The Menu Bar provides direct access to the functionality of the MDS Explorer. It can be used instead of and/or 
in addition to the context menus which are provided by the different branches of the MDS Explorer. 

The following functionality is available via the File menu: 

Menu Item Description 

Load Offline Data opens the ODL Standard T001 

Refresh re-reads all information from the currently connected X-Tools Servers 

Hide hides the MDS Explorer 

The following functionality is available via the Edit menu: 

Menu Item Description 

Expand expands the currently selected item(s) 

Expand all expands all present items 

Collapse collapses the currently selected item(s) 

Collapse all collapses all present items 

Cut cuts the currently selected item(s) 

Copy copies the currently selected item(s) 

Paste pastes the currently cut/copied item(s) 

Remove removes the currently selected item(s) 

Rename allows to rename the selected item directly within the MDS Explorer 

New Category… opens the Add Category dialog and creates a new category afterwards 

Find puts the search edit box of the Search Area into editing mode 

Find References… opens the Find References dialog 

Add Scalar Data… opens the Add Scalar Data dialog 

Edit Scalar Data… opens the Edit Scalar Data dialog 

The following functionality is available via the Run menu: 

Menu Item Description 

Store stores the currently selected items and their sub-items using the default configuration for the stor-
age process 

Export exports the currently selected items and their sub-items using the default configuration for the 
export process 

Advanced Store opens the Advanced Store dialog and stores the selected items and their sub-items according to 
the chosen options afterwards 

Advanced Export opens the Advanced Export dialog and exports the selected items and their sub-items according 
to the chosen options afterwards 

Fast Analysis > … starts a fast analysis for the currently selected data 

The following functionality is available via the View menu: 

Menu Item Description 

Title Bar toggles whether the Title Bar shall be shown or hidden 

Menu Bar toggles whether the Menu Bar shall be shown or hidden 

The following functionality is available via the Window menu: 

Menu Item Description 

Dock toggles whether MDS Explorer shall be docked to the left or not 

Size > … changes the size of the MDS Explorer 



CMS X-Tools - User Manual - 02 - X-Tools Client CMS 

 

English  
Release 2016-10  12 / 25 

 

2.2.3 MDS Explorer Tree 

2.2.3.1 Overview 

Each branch of the MDS Explorer has a defined task and provides certain functionalities. The following major 
branches are provided by the MDS Explorer: 

 Main Branch 

 Servers Branch 

 Server Branch 

 Online Data Branch 

 Offline Data Branch 

 Scalar Data Branch 

2.2.3.2 Main Branch 

The one and only Main Branch provides all of the other items of the MDS Explorer. It can be expanded and 
collapsed in order to show or hide its sub-items. 

2.2.3.3 Servers Branch 

The one and only Servers Branch provides all of the X-Tools Servers which are connected at the moment. The 
tree of shown X-Tools Servers is updated automatically whenever a server is attached or detached. 

2.2.3.4 Server Branch 

Each Server Branch represents one of the currently connected X-Tools Servers. 

The following specific context menu item is provided: 

Context Menu Item Description 

Find References… opens the Find References dialog for the chosen X-Tools Server 

2.2.3.5 Online Data Branch 

Each Online Data Branch provides all of the online data which is currently available at its parent X-Tools Serv-
er. 

Via the context menu of the Online Data Branch and its sub-branches, online data categories can be created, 
edited and removed. In addition, online data can be dragged from the All Online Data Branch to any of the cre-
ated online data categories in order to create a customized view onto the currently present online data. 

The currently available online data can be dragged from the MDS Explorer into the other systems of X-Tools in 
order to use them there. In case an online data category is being dragged into another system of X-Tools the 
system behaves as if all of the contained online data would be dragged. 

The Online Data Branch and each of its sub-branches shows the total number of its below online data. As online 
data can be grouped within categories and as each online data may be present in multiple categories simulta-
neously, the counted number of data all sub-branches of a branch can sum up to more than the counted num-
ber of data of the parent branch. This is caused by the fact that each branch counts each unique online data 
only once, no matter in how many sub-categories it is present. 
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The following specific context menu items are provided: 

Context Menu Item Description 

Find References… opens the Find References dialog for the chosen online data 

Cut cuts the currently selected item(s) 

Copy copies the currently selected item(s) 

Paste pastes the currently selected item(s) 

Remove removes the currently selected item(s) 

Rename allows to rename the selected item directly within the MDS Explorer 

New Category… opens the Add Category dialog and creates a new category afterwards 

Fast Analysis > … starts a fast analysis for the currently selected online data 

2.2.3.6 Offline Data Branch 

Each Offline Data Branch provides all of the offline data which is currently available at its parent X-Tools Serv-
er. 

Via the context menu of the Offline Data Branch and its sub-branches, offline data categories can be created, 
edited and removed. In addition, offline data can be dragged from the All Offline Data Branch to any of the cre-
ated offline data categories in order to create a customized view onto the currently present offline data. 

The currently available offline data can be dragged from the MDS Explorer into the other systems of X-Tools in 
order to use them there. In case an offline data category is being dragged into another system of X-Tools the 
system behaves as if all of the contained offline data would be dragged. 

The Offline Data Branch and each of its sub-branches shows the total number of its below offline data. As offline 
data can be grouped within categories and as each offline data may be present in multiple categories simulta-
neously, the counted number of data all sub-branches of a branch can sum up to more than the counted num-
ber of data of the parent branch. This is caused by the fact that each branch counts each unique offline data 
only once, no matter in how many sub-categories it is present. 

The following specific context menu items are provided: 

Context Menu Item Description 

Find References… opens the Find References dialog for the chosen offline data 

Cut cuts the currently selected item(s) 

Copy copies the currently selected item(s) 

Paste pastes the currently selected item(s) 

Remove removes the currently selected item(s) 

Rename allows to rename the selected item directly within the MDS Explorer 

New Category… opens the Add Category dialog and creates a new category afterwards 

Store stores the currently selected items and their sub-items using the default configuration for the stor-
age process 

Export exports the currently selected items and their sub-items using the default configuration for the 
export process 

Advanced Store… opens the Advanced Store dialog and stores the selected items and their sub-items according to 
the chosen options afterwards 

Advanced Export… opens the Advanced Export dialog and exports the selected items and their sub-items according 
to the chosen options afterwards 

Fast Analysis > … starts a fast analysis for the currently selected offline data 
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Store 

The used configuration for the storage process matches the default configuration which is being used by the 
Advanced Store dialog. 

While the storing of the offline data is going on, the Storage Progress dialog is being displayed. The Cancel 
button can be used in order to cancel the ongoing storage operation. 

 

Figure 3: Storage Progress Dialog 

Export 

The default configuration for the export process matches the default configuration of the Advanced Export 
dialog. 

While the exporting of the offline data is going on, the Export Progress dialog is being displayed. The Cancel 
button can be used in order to cancel the ongoing export operation. 

 

Figure 4: Export Progress Dialog 

2.2.3.7 Scalar Data Branch 

Each Scalar Data Branch provides all of the scalar data which is currently available at its parent X-Tools Serv-
er. 

Via the context menu of the Scalar Data Branch and its sub-branches, scalar data can be added, edited and 
removed. 

The currently available scalar data can be dragged from the MDS Explorer into the other systems of X-Tools in 
order to use them there. In case a scalar data category is being dragged into another system of X-Tools the 
system behaves as if all of the contained scalar data would be dragged. 

The Scalar Data Branch and each of its sub-branches shows the total number of its below scalar data. 

The following specific context menu items are provided: 

Context Menu Item Description 

Find References… opens the Find References dialog for the chosen scalar data 

Remove removes the currently selected item(s) 

Add Scalar Data… opens the Add Scalar Data dialog 

Edit Scalar Data… opens the Edit Scalar Data dialog 
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2.2.4 Find References Dialog 

2.2.4.1 Overview 

The following screenshot shows an example of a Find References dialog: 

 

Figure 5: Example of a Find References Dialog 

2.2.4.2 Find Settings Table 

The Find Settings table contains the parameters which shall be used during the search of the references: 

Parameter Description 

Target Name Contains the name of the X-Tools Server for which the dialog has been called. 

Find what Allows to enter the string which shall be found. 

Scope Allows to choose where the search operation shall take place. 

Find what 

The search operation is not case sensitive and can be used in order to find data names within any of the Con-
figuration Files of X-Tools (Device Profiles, Monitoring Views, Analyzing Models, Analyzing Scripts, User Func-
tions, Storage Profiles and Loading Profiles). 

It is not possible to find items or values which are not data names. 

Scope 

Scope Description 

Search everywhere searches for the specified find string within all Configuration Files 

Search only the DMS 
(Device Profiles) 

searches for the specified find string only within the Configuration Files of the 
Device Management System 

Search only the MTS 
(Monitoring Views) 

searches for the specified find string only within the Configuration Files of the 
Monitoring System 

Search only the ANS 
(Analyzing Models, Analyzing Scripts and User Functions) 

searches for the specified find string only within the Configuration Files of the 
Analyzing System 

Search only the STS 
(Loading Profiles and Storage Profiles) 

searches for the specified find string only within the Configuration Files of the 
Storage System 
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2.2.4.3 Find Results Table 

The Find Results table receives the the results of the search: 

Parameter Description 

File Name receives the name of the Configuration File which contains the find string 

File Type receives the type of the Configuration File which contains the find string 

Modification Date receives the last modification date of the Configuration File which contains the find string 

A double-click onto any row of the Find Results table opens the displayed Configuration File within its according 
editor. 

2.2.5 Advanced Store Dialog 

2.2.5.1 Overview 

The following screenshot shows an example of an Advanced Store dialog: 

 

Figure 6: Example of an Advanced Store Dialog 
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2.2.5.2 Storing Parameters Table 

The Storing Parameters table contains the parameters which shall be applied when the selected items and their 
sub-items are being stored: 

Parameter Description 

Storage Location allows to switch between the already defined storage locations and to define additional storage 
locations 

Storage Path allows to choose the desired path below the specified storage location 

Storage Mode contains the storage mode which shall be applied 

Storage Parameters contains the storage parameters which shall be applied 

Time Input Mode allows to switch between the available time input modes 

Time Domain allows to switch between the available time domains 

Minimum Time Format allows to switch between the available input formats for the minimum time 

Minimum Time Value allows to enter the minimum time of the data which shall be loaded 

Time Interval Format allows to switch between the available input formats of the time interval 

Time Interval Value allows to enter the time interval of the data which shall be loaded 

Maximum Time Format allows to switch between the available input formats for the maximum time 

Maximum Time Value allows to enter the maximum time of the data which shall be loaded 

Data Category allows to enter the data category which shall be set for the to-be-stored data 

Storage Mode 

Storage Mode Description 

Each Value In this storage mode, each value from the data buffer is being stored. 

Changes only In this storage mode, a value from the data buffer is being stored only in case the difference be-
tween the value from the data buffer and the last value which has been stored is bigger than the 
specified hysteresis. 

Changes and Interval In this storage mode, a value from the data buffer is being stored in case the difference between 
the value from the data buffer and the last value which has been stored is bigger than the speci-
fied hysteresis. In addition, the last known value from the data buffer is being stored each amount 
of time which is specified as interval. 

Interval only In this storage mode, a value from the data buffer never is being stored directly. Instead, the last 
known value from the data buffer is being stored each amount of time which is specified as inter-
val. 

Storage Parameter 

Storage Parameter Description 

N/A This storage parameter is relevant for the storage mode Each Value only and is being applied 
automatically in case this storage mode is being chosen. 

Hysteresis This storage parameter allows specifying via edit box the hysteresis for to be stored values and is 
being applied automatically in case the storage mode Changes Only is being chosen. 

Hysteresis and Interval These storage parameters allow to specify via edit box the hysteresis and the amount of time for 
the to be stored values and are being applied automatically in case the storage mode Changes 
and Interval is being chosen. 

Interval This storage parameter allows specifying via edit box the amount of the time for to be stored val-
ues and is being applied automatically in case the storage mode Interval Only is being chosen. 

Time Input Mode 

Time Input Mode Description 

None In this time input mode, the full available time interval of the selected offline data is being stored. 

Minimum Time and Time Interval In this time input mode, the time interval which is specified via the Minimum Time Value and Time 
Interval Value parameters is being stored. 

Minimum Time and Maximum Time In this time input mode, the time interval which is specified via the Minimum Time Value and Max-
imum Time Value parameters is being stored. 

Time Interval and Maximum Time In this time input mode, the time interval which is specified via the Time Interval Value and Maxi-
mum Time Value parameters is being stored. 
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Time Domain 

Time Domain Description 

Absolute Times When the time domain is set to “Absolute Times”, the Minimum Time Value and Maximum Time 
Value rows expect the user input as absolute times. 

Relative Times When the time domain is set to “Relative Times”, the Minimum Time Value and Maximum Time 
Value rows expect the user input as relative times. 

Data Category 

In case a data category is specified, the specified data category is written to the stored files. A backslash (“\”) or 
slash (“/”) can be used in order to specify sub-categories. Examples: 

 Some Category 

 Plant\Machine\Sensor 

In case an empty string is set as data category, the default category of each data is stored into the created of-
fline data file. 

2.2.5.3 Menu Bar 

The Save As… button can be used in order to store the current settings from the Advanced Store dialog as new Loading Profile so that 

these settings can be re-used later also outside the Advanced Store dialog. 

2.2.6 Advanced Export Dialog 

2.2.6.1 Overview 

The following screenshot shows an example of an Advanced Export dialog: 

 

Figure 7: Example of an Advanced Export Dialog 
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2.2.6.2 Exporting Parameters Table 

The Exporting Parameters table contains the parameters which shall be applied when the selected items and 
their sub-items are being exported: 

Parameter Description 

Export Location allows to switch between the already defined storage locations and to define additional storage 
locations 

Export Path allows to choose the desired path below the specified storage location 

Export File Type allows to switch between the available export file types 

File Creation Mode allows to switch between the available file creation modes 

Timestamp Format allows to switch between the available timestamp formats 

Decimal Precision allows to switch between the available decimal precisions 

Export Mode contains the export mode which shall be applied 

Export Parameters contains the export parameters which shall be applied 

Time Input Mode allows to switch between the available time input modes 

Time Domain allows to switch between the available time domains 

Minimum Time Format allows to switch between the available input formats for the minimum time 

Minimum Time Value allows to enter the minimum time of the data which shall be loaded 

Time Interval Format allows to switch between the available input formats of the time interval 

Time Interval Value allows to enter the time interval of the data which shall be loaded 

Maximum Time Format allows to switch between the available input formats for the maximum time 

Maximum Time Value allows to enter the maximum time of the data which shall be loaded 

Data Category allows to enter the data category which shall be set for the to-be-exported data 

Export Location 

The desired export location for the data can be chosen by selecting of an already defined storage location via 
the provided combo box, which contains the symbolic names of all of the currently known root data locations of 
the source X-Tools Server of the selected data. 

The last entry of the combo box is “…” and opens the Add Location dialog when it is being chosen. When a 
new storage location has been defined via the Add Location dialog, it is added to the Export Location combo 
box automatically and automatically becomes the currently selected one. 

Export Path 

The Export Path contains the name of the used location as well as the following path of directories. 

Export File Type 

Export File Type Description 

.csv (Comma separated Values) When the export file type is set to “.csv (Comma separated Values)”, the selected items and their 
sub-items are being exported to .csv compatible files. 

.dat (DIAdem Data Format) When the export file type is set to “.dat (DIAdem Data Format)”, the selected offline data are being 
exported to .dat compatible files. 

File Creation Mode 

File Creation Mode Description 

One Export File per offline Data When the file creation mode is “One Export File per offline Data”, the export creates one file which 
contains all of the probes of one of the currently to-be-exported offline data. 

One Export File per Probe When the file creation mode is “One Export File per Probe”, the export creates one file for each 
probe (= 1 timestamp + 1 value) of the currently to-be-exported offline data. 
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Timestamp Format 

Timestamp Format Description 

ns When the timestamp format is set to “ns”, timestamps are written into the exported file as ns since 
1970-01-01 00:00:00 GMT (in case of absolute timestamps) or as ns since 000000 00:00:00 (in 
case of relative timestamps). 

Date + Time + ns (GMT) When the timestamp format is set to “Date + Time + ns (GMT)”, timestamps are written into the 
exported file as date, time and ns in GMT (in case of absolute timestamps) or as time and ns (in 
case of relative timestamps). 

Date + Time + ns (Local Time) When the timestamp format is set to “Date + Time + ns (Local Time)”, timestamps are written into 
the exported file as date, time and ns in local time (in case of absolute timestamps) or as time and 
ns (in case of relative timestamps). 

Decimal Precision 

Decimal Precision Description 

Automatic When the decimal precision is set to “Automatic”, decimal values are written into the exported file 
with the maximal available accuracy of each value. Thus, the number of digits after the comma 
can vary in between the values within one line and in between the values of one data from line to 
line. 

0, 3, 6, 9 or 12 When the decimal precision is set to “0”, “3”, “6”, “9” or “12”, decimal values are written into the 
exported file with the specified number of digits. 

Export Mode 

Export Mode Description 

Each Value In this export mode, each value from the data buffer is being exported. 

Changes only In this export mode, a value from the data buffer is being exported only in case the difference 
between the value from the data buffer and the last value which has been exported is bigger than 
the specified hysteresis. 

Changes and Interval In this export mode, a value from the data buffer is being exported in case the difference between 
the value from the data buffer and the last value which has been exported is bigger than the speci-
fied hysteresis. In addition, the last known value from the data buffer is being exported each 
amount of time which is specified as interval. 

Interval only In this export mode, a value from the data buffer never is being exported directly. Instead, the last 
known value from the data buffer is being exported each amount of time which is specified as 
interval. 

Export Parameter 

Export Parameter Description 

N/A This export parameter is relevant for the storage mode Each Value only and is being applied au-
tomatically in case this storage mode is being chosen. 

Hysteresis This export parameter allows specifying via edit box the hysteresis for to be stored values and is 
being applied automatically in case the storage mode Changes Only is being chosen. 

Hysteresis and Interval These export parameters allow to specify via edit box the hysteresis and the amount of time for 
the to be stored values and are being applied automatically in case the storage mode Changes 
and Interval is being chosen. 

Interval This export parameter allows specifying via edit box the amount of the time for to be stored values 
and is being applied automatically in case the storage mode Interval Only is being chosen. 
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Time Input Mode 

Time Input Mode Description 

None In this time input mode, the full available time interval of the selected offline data is being export-
ed. 

Minimum Time and Time Interval In this time input mode, the time interval which is specified via the Minimum Time Value and Time 
Interval Value parameters is being exported. 

Minimum Time and Maximum Time In this time input mode, the time interval which is specified via the Minimum Time Value and Max-
imum Time Value parameters is being exported. 

Time Interval and Maximum Time In this time input mode, the time interval which is specified via the Time Interval Value and Maxi-
mum Time Value parameters is being exported. 

Time Domain 

Time Domain Description 

Absolute Times When the time domain is set to “Absolute Times”, the Minimum Time Value and Maximum Time 
Value rows expect the user input as absolute times. 

Relative Times When the time domain is set to “Relative Times”, the Minimum Time Value and Maximum Time 
Value rows expect the user input as relative times. 

Data Category 

In case a data category is specified, the specified data category is written to the exported files. A backslash (“\”) 
or slash (“/”) can be used in order to specify sub-categories. Examples: 

 Some Category 

 Plant\Machine\Sensor 

In case an empty string is set as data category, the default category of each data is used for the export. 

2.2.6.3 Menu Bar 

The Save As… button can be used in order to store the current settings from the Advanced Export dialog as new Loading Profile so that 
these settings can be re-used later also outside the Advanced Export dialog. 

2.2.7 Add Scalar Data Dialog 

2.2.7.1 Overview 

The following screenshot shows an example of an Add Scalar Data dialog: 

 

Figure 8: Example of an Add Scalar Data Dialog 
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2.2.7.2 Scalar Data Table 

The Scalar Data table contains the parameters which shall be applied to the to-be-created scalar data: 

Parameter Description 

Name Allows to enter the name of the new scalar data. 

Unit Allows to enter the unit of the new scalar data. 

Description Allows to enter the description of the new scalar data. 

Data Type Allows to enter the data type of the new scalar data. 

Size Allows to enter the size of the new scalar data. This parameter is enabled only in case the chosen 
Data Type is “String”. 

Timestamp This value is disabled and can not be edited. 

Value Allows to enter the initial value of the new scalar data. 

Lifetime Allows to choose the lifetime of the new scalar data. 

Name 

The Name can not contain any character which is not allowed in file names and must be unique among the 
currently present scalar data. 

The Name can contain one or multiple dots (“.”), which can be used in order to create structures of scalar data. 

Timestamp 

The Timestamp can not be edited manually. Instead, it is set to the date and time of the last modification of the 
scalar data automatically whenever any parameter of a scalar data is changed. 

Lifetime 

Lifetime Description 

permanent Scalar data with a Lifetime of “permanent” are stored by the X-Tools Server into a permanent 
memory and are restored during each startup of the X-Tools Server. 

temporary Scalar data with a Lifetime of “temporary” are not restored during the next startup of the X-Tools 
Server. 

2.2.8 Edit Scalar Data Dialog 

2.2.8.1 Overview 

The following screenshot shows an example of an Edit Scalar Data dialog: 

 

Figure 9: Example of an Edit Scalar Data Dialog 
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2.2.8.2 Scalar Data Table 

The Scalar Data table contains the parameters of the to-be-edited scalar data: 

Parameter Description 

Name Allows to change the name of the existing scalar data. 

Unit Allows to change the unit of the existing scalar data. 

Description Allows to change the description of the existing scalar data. 

Data Type Allows to change the data type of the existing scalar data. 

Size Allows to change the size of the existing scalar data. This parameter is enabled only in case the 
chosen Data Type is “String”. 

Timestamp This value is disabled and can not be edited. 

Value Allows to change the value of the existing scalar data. 

Lifetime Allows to change the lifetime of the existing scalar data. 

2.2.9 Search Area 

2.2.9.1 Overview 

The following screenshot shows an example of the Search Area: 

 

Figure 10: Example of a Search Area within the MDS Explorer 
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2.2.9.2 Searchable Items 

The entered search string can be used in order to find items of the following types: 

 Online Data Category Branches 

 Online Data Branches (including their sub-items like “Description”, “Start Date”, …) 

 Offline Data Category Branches 

 Offline Data Branches (including their sub-items like “Description”, “Start Date”, …) 

 Scalar Data Category Branches 

 Scalar Data Branches (including their sub-items like “Description”, “Unit”, …) 

The search is case-insensitive and does not search for whole words (thus, also a search string like “dat” can be 
entered in order to find something like “My Data”). 

2.2.9.3 Keyboard Operations 

The following operations can be performed via the keyboard: 

Keyboard Operation Description 

<Ctrl> + <F> puts the search string editing box into editing mode 

<Enter> in case the search string edit box is in editing mode and <Enter> is pressed, the MDS Explorer 
searches for the entered search string from the current selection within the MDS Explorer down-
wards 

<F3> searches for the current search string from the current selection within the MDS Explorer down-
wards (this behavior is the same as if the Next button would be pressed) 

<Shift> + <F3> searches for the current search string from the current selection within the MDS Explorer up-
wards (this behavior is the same as if the Previous button would be pressed) 

2.2.9.3.1 Buttons 

The following operations can be performed via the displayed buttons: 

Button Description 

Previous searches for the current search string from the current selection within the MDS Explorer up-
wards 

Next searches for the current search string from the current selection within the MDS Explorer down-
wards 
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3 Contact Information 

 

Should you have any questions concerning the software application, please refer to the Industry Sector Tech-
nical Support. 

 

Department 

Siemens AG 

Industry Sector 

Phone 

+49 (0) 911 895 7222 (Monday to Friday, 09:00 am to 05:00 pm CET/CEST) 

Fax 

+49 (0) 911 895 7223 

Internet 

https://support.industry.siemens.com/  

 

Thank you for using one of the above mentioned contacts to ensure your inquiry is registered and can be pro-
cessed. 

 

https://support.industry.siemens.com/
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